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1 Preface 

When attempting to repair software on a PC, often the easiest or fastest method of 

repair is achieved by reinstalling Windows from scratch. This is sometimes called an 

OS reimage. By utilizing Intel® vPro™ technology in the process, an OS reimage can 

be completed remotely. In other words, Intel vPro technology brings this capability, 

which is traditionally performed on site by a desk side technician, into the hands of the 

help desk technician. This document outlines basic steps to perform remote OS 

reimaging. 

 

1.1 Document Scope 

This document outlines various methods for delivering new OS Images remotely. Each 

method outlines using various ISV OS image deployment tools, including 

customizations needed for remote use. The goal is that, by reviewing the various 

options, methods, and tools, the reader may choose and adapt a setup the best suits 

their needs.   

This document does not cover troubleshooting steps that may lead to an OS reimage. 

1.2 Intended Audience 

This document is intended for Information Technology (IT) professionals who create 

processes for service desks. It will show how Intel vPro technology based systems can 

make remote diagnosis and repair easier.  IT Professionals who manage OS image 

deployment or who are attempting to deploy and use this usage model will also find 

value in this document. Readers should have a basic working familiarity with Intel vPro 

technology, and the configuration and use of the Intel® Active Management 

Technology (Intel® AMT) platform for out-of-band (OOB) management.  Readers 

should also be familiar with the basics of IT infrastructure, especially networked 

environments and their component technologies.   

 

1.3 Related Documentation and Software 

The download site for this and other Solution Reference Designs: 

http://www.intel.com/content/www/us/en/remote-support/vpro-technology-solutions-

reference-designs.html 

 

The download site for all Use Case Reference Designs: 

http://www.intel.com/content/www/us/en/remote-support/vpro-technology-solutions-

reference-designs.html 
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Intel® vPro™ Expert Center – “Enhanced Remote Repair with WinPE” 

http://communities.intel.com/docs/DOC-5095  

 

Technet – “Work with Windows PE” 

http://technet.microsoft.com/en-us/library/cc766387(WS.10).aspx 

 

Technet – “Windows Automated Install Kit” 

http://technet.microsoft.com/en-us/library/dd349343(WS.10).aspx  

 

Install the WAIK tools from: 

http://www.microsoft.com/downloads/en/details.aspx?familyid=696DD665-9F76-

4177-A811-39C26D3B3B34&displaylang=en  

C:\Program Files\Windows AIK\Docs\Whitepapers\stepbystep_itpro.htm  

 

Remote ISO Launcher v1.0 

http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20961&lang=eng

&OSVersion=&DownloadType=  

 

Two Stage Boot Process – optional alternative to speed up the WinPE boot (see Section 

3.6.7.2 on page 31) 

http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20960&lang=eng

&OSVersion=&DownloadType=   

 

Microsoft Deployment Toolkit: 

 

http://technet.microsoft.com/en-us/solutionaccelerators/dd407791 

 

Windows Deployment Services:  

 

Technet – “WDS Quick Start Guide” 

http://technet.microsoft.com/en-us/library/cc771670(WS.10).aspx 

 

Technet – “WDS” 

http://technet.microsoft.com/en-us/library/cc772106(WS.10).aspx 

 

http://communities.intel.com/docs/DOC-5095
http://technet.microsoft.com/en-us/library/cc766387(WS.10).aspx
http://technet.microsoft.com/en-us/library/dd349343(WS.10).aspx
http://www.microsoft.com/downloads/en/details.aspx?familyid=696DD665-9F76-4177-A811-39C26D3B3B34&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=696DD665-9F76-4177-A811-39C26D3B3B34&displaylang=en
http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20961&lang=eng&OSVersion=&DownloadType
http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20961&lang=eng&OSVersion=&DownloadType
http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20960&lang=eng&OSVersion=&DownloadType
http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20960&lang=eng&OSVersion=&DownloadType
http://technet.microsoft.com/en-us/solutionaccelerators/dd407791
http://technet.microsoft.com/en-us/library/cc771670(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc772106(WS.10).aspx
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2 Introduction 

This document provides guidance on performing a remote OS re-image using Intel 

vPro technology features in combination with existing OS imaging tools. Several tools 

and methods are covered, with each tool/method having its own section in the 

document. Each section will include a brief overview of the process, detailed steps, and 

a conclusion with thoughts more possibilities. 

The following tools/methods are covered in this document: 

 Windows Automated Install Kit (WAIK) 

 Windows Deployment Services 

 Windows Deployment Toolkit 

NOTE 

While it is possible to reimage your managed client using a basic method of IDEr 

booting a Windows install CD, it is recommended that you use one of the methods 

described in the body of this document.  
 

2.1 Use Case Overview 

In this use case a Knowledge Worker has contacted a Service Desk Technician for help 

with an issue. In troubleshooting the issue, the Technician has determined that 

reimaging the OS is the best course of action to get the Worker back up and running.  

NOTE 

Section 2.1 is a general overview and applies to all tools/methods covered in the 

subsequent sections of this document. 
 

2.1.1 Preconditions 
 Intel vPro technology is set up and configured on the managed clients 

 Technician has tools and credentials to use Intel vPro technology 

 Intel AMT (v6.0 and above) can be contacted on the network 

NOTE 

IEEE 802.11x WLAN specification is NOT supported by this reference design. 
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2.1.2 Use Case  
1. The Technician establishes a connection to the Worker’s Intel vPro technology 

enabled PC (the “managed” PC).  

2. A reboot command is issued, causing the managed PC to reboot to a recovery OS 

image.  

3. This image facilitates the process of applying a new OS to the managed PC’s hard 

disk.  

4. If interaction with the image or new OS is required it is either: 

a) driven by the technician remotely 

b) driven by the user 

5. Worker’s PC is back up and running. 
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3 Windows Automated Install Kit 

This section covers a remote install using the Windows Automate Install Kit (WAIK) 

and scripts provided with this use case reference design.  

3.1 Overview 

With Microsoft’s Windows Automated Install Kit (WAIK), Windows can be installed from 

sources other than Windows Install media, including from a network resource.  Using 

Intel vPro technology, the process can be initiated and monitored remotely, creating a 

simple, efficient remote deployment.  The WAIK can also automate some or all OS 

deployment tasks. 

Included in the .zip file for this document is an ISO_Builder package called OS_Image 

designed to automate remote Windows 7 installs.  This package automatically adds 

scripts into WinPE that take advantage of Intel AMT, startnet.cmd, and other WAIK 

features. 

NOTE 

The scripts and steps below are adapted from (http://technet.microsoft.com/en-

us/library/dd349348(WS.10).aspx) 

 

3.2 Remote OS Installation Flow 

In this solution a Knowledge Worker has contacted a Service Desk Technician for help 

with an issue. In troubleshooting the issue, the Technician has determined that 

reimaging the OS is the best course of action to get the Worker back up and running. 

Here is where the use case starts.  

1. The Technician establishes a connection to the Worker’s Intel vPro technology 

enabled PC (the “managed” PC).  

2. A reboot command is issued, causing the managed PC to reboot to a recovery OS 

image.  

3. This image starts the process of applying a new OS to the managed PC’s hard disk: 

c) Partitions and formats the hard disk as needed. 

d) Locates a fresh OS image on a network share. 

e) Installs this image to the managed PC’s hard disk. 

f) Reboots the managed PC into the new Windows installation. 

Any OS customization required is performed via KVM Remote Control by the Help Desk 

Technician.  This may include naming the OS, joining a domain, installing applications, 

etc.  Specific OS customization steps are outside of the scope of this document. 

 

http://technet.microsoft.com/en-us/library/dd349348(WS.10).aspx)
http://technet.microsoft.com/en-us/library/dd349348(WS.10).aspx)
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3.2.1 Hard Drive Partitioning 

There are two options for hard drive partitioning.  First, the entire hard drive may be 

used in a single partition.  In this mode, all data on the hard drive is lost when 

applying a fresh OS image.  The second option uses two hard disk partitions.  In this 

case, when a fresh OS image is applied, it is possible to only format the first partition, 

leaving any data on the second partition.  Further, the second partition may be used to 

store a fresh copy of the OS image.  As long as the image is available and current on 

the second partition, it will be applied without downloading from the network share. 

This will save time and network resources.  As such, the two partition scheme is 

recommended. 

NOTE 

As of this release, the included script does not support GPT partitioning. 

 

3.2.2 Network Share for OS Image Storage and Delivery 

To facilitate installation of the fresh OS image, the image is stored on a network 

location.  This location must be accessible from the managed PC.  This document 

outlines creating the share on the Help Desk Console PC.  While this location is 

appropriate for lab scenarios, in a production environment it is best to place the image 

on the network edge, as close to the managed PC as possible.  This may be 

accomplished by a Distributed File system, or other means.  However, placing the 

image at the network edge is not covered by this document. 

Another consideration is security.  Credentials used by the recovery OS to access this 

share may be compromised if a user gains access to the recovery.  As such, it is 

recommended to limit the attack surface by creating a special account that has read 

only access to this share and no others.  This way, if the account is compromised, the 

only files exposed are those on this share. 

 

3.3 Use Case Preparation 

Pre-work for this use case includes the following: 

1. Create a network share on which to store the fresh OS image. 

2. Create a fresh OS image. Steps in this document outline creating a fresh Win7, 

sysprepped install. 

3. Create the recovery OS required to apply the fresh OS image.  This document 

outlines using the included ISO Builder tool to create a WinPE image. 

4. Use the recovery OS to capture and store the fresh OS image onto the network 

share. 

5. Provide Service Desk Technicians with the tools and training needed to perform the 

solution. This solution describes using RealVNC VNC* Viewer Plus and Remote ISO 

Launcher as the Service Desk tools.  Other tools may be used, however they are 

beyond the scope of this document. 
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6. Partition all Intel vPro technology enabled managed systems with 2 partitions and 

copy the fresh OS image to the secondary partition.  This step is optional and, as 

such, detailed steps are not provided.  

3.4 Assumptions and Limitations 

The detailed steps in this document have the following assumptions 

1. All managed systems support KVM Remote Control. 

2. Intel AMT is set up and configured without TLS on all managed systems. 

3. The Service Desk Technician has valid Intel AMT credentials needed to access and 

use IDE Redirection, Serial Over LAN, Remote Control, and KVM Remote Control 

features. 

4. The fresh OS is Windows 7.  Other operating systems, including Windows XP, are 

not covered by this document. 

5. OS customization is performed manually.  While it is possible to automate OS 

customization tasks, this is outside the scope of this document.  OS customization 

includes, but is not limited to: 

 OS name 

 Joining an Active Directory Domain 

 Installing applications or software agents 

6. User Data is not accounted for.  Note that any user data stored on the primary 

partition will be lost during the reimage process.  Any data stored on the secondary 

partition will be retained. 

 

Based on the above requirements, it is recommended that this process is best for use 

on systems that do not retain user data and are not customized based on specific user 

needs.  For example, lab systems or systems in a doctor’s office where all data is 

stored on the back end are good candidates.  

NOTE 

It is possible to accommodate user data and OS customization, and broaden the 

supported OSs, Intel AMT versions, etc.  Future revisions of this document may 

address some or all of these limitations. 
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3.5 Requirements 

 

Network with 
DHCP Server 

 

Reference 
Computer 

 Intel AMT 6.0 or higher 

Used to create the fresh OS image. This PC will have a fresh copy of 

Windows 7 installed. 

For the purpose of the lab, this PC may also be used as the Managed 

Client with Intel vPro Technology. 

Development 
Computer 

 Any PC with Microsoft* Windows 7.  

Used to create the recovery OS. 

For the purpose of the lab, this PC may also be used as the Service Desk 

Console. 

Service Desk 
Console 

 Any PC with Microsoft Windows 7. 

PC used by the Service Desk technician to remotely control the Knowledge 

Workers PC in the use case. 

Managed Client 
with Intel vPro 
technology 

 Intel AMT 6.0 or higher 

 Intel Integrated Graphics 

 Configured for non-TLS and Digest credentials.  

This PC will have its OS reimaged during this use case. 

Note: Kerberos credentials are supported but not shown in this 

document. 
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3.6 Detailed Steps 

3.6.1 Create a Share for Storing the Fresh OS Image 

Perform all steps in the following subsections on the Service Desk Console. 

3.6.1.1 Create Special User Accounts 

Create special user accounts for the OS imaging process: OSDeploy, and OSCapture. 

1. Right-click Computer and select Manage. 

2. Expand Computer Management -> System Tools -> Local Users and Groups -> 

Users. 

3. Right-click Users and select New User. 

4. User Name: OSDeploy 

5. Password: Your Choice. We use P@ssw0rd for the lab. 

6. Deselect User must Change Password…. 

7. Select User cannot change password and Password Never Expires. 

8. Click Create. 

9. User Name: OSCapture 

10. Password: Your Choice. We use P@ssw0rd for the lab. 

11. Deselect User must Change Password…. 

12. Select User cannot change password and Password Never Expires. 

13. Click Create. 

14. Click Close. 

15. Close the Computer Management Window. 

3.6.1.2 Create a New Folder c:\os_image 
1. Open Computer. 

2. Double-click C:. 

3. Right-click in white space in the window and select New -> Folder. 

4. Name the folder OS_Image. 

3.6.1.3 Create the Share 
1. Right-click OS_Image and select Share with -> Specific People. 

2. Using the Permission Level drop-down menu, remove as many users as possible. 

Note: the owner cannot be removed. 

3. From the drop down list, select OSDeploy and click Add. 

4. From the drop down list, select OSCapture and click Add. 

5. Using the Permission Level drop down, set OSCapture permissions to 

Read/Write. 

6. Click Share. 

7. Click Done. 
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3.6.2 Create the Fresh OS Image 

The steps below are used to build a Windows 7 sysprep image.  The following steps 

show how to create an answer file using the Windows automated installation kit 

(WAIK) to create base image, add basic configuration settings, create a sysprep 

answer file, and sysprep the image. 

 

3.6.2.1 Gather Required Files 

Locate a Windows 7 installation DVD. It will be required for subsequent steps. 

On the Development PC, click the link below to obtain the Windows Automated 

Installation Kit for Windows 7. 

http://www.microsoft.com/download/en/details.aspx?id=5753 

This results in an .iso file.  Mount this .iso file (we suggest using Virtual CloneDrive for 

mounting .iso files) or burn it to a DVD and insert the DVD. 

Install the WAIK with default options (select Windows AIK Setup from the CD’s 

default GUI menu). 

 

3.6.2.2 Building the Answer File 

On the Development PC, do the following: 
 

1. Insert the Windows 7 installation DVD. 

2. Navigate to the \Sources directory on your DVD-ROM drive and copy the 

Install.wim file from the Windows product DVD to a location on the computer. 

3. To open Windows SIM, click Start, click All Programs, click Microsoft Windows AIK, 

and then click Windows System Image Manager. 

4. On the Windows SIM File menu, click Select Windows Image. 

5. In the Select a Windows Image dialog box, navigate to the location where you 

saved Install.wim in step 2, and then click Open. 

You will be prompted to select an image. Choose the Windows image that you want 

to install, and then click OK. 

You will be prompted to create a catalog file. Click Yes to generate the file. 

If you are prompted to approve the program by a User Account Control window, 

you can select to allow the program or cancel the installation. 

6. On the File menu, click New Answer File. An empty answer file appears in the 

Answer File pane. 

7. In the Windows SIM Windows Image pane, expand the Components node to 

display available settings. 

8. On the expanded list of components, add the components in the table below to 

your answer file by right-clicking the component, and then selecting the 

appropriate configuration pass. This action adds the component to your answer file 

in the specified configuration pass, or phase, of Windows installation. If multiple 

http://www.microsoft.com/download/en/details.aspx?id=5753
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Architectures are listed (i.e., amd64, wow64, or x86); choose the one that 

matches the Windows 7 installation media. 
 

Component Configuration pass 

Microsoft-Windows-Deployment\Reseal oobeSystem 

Microsoft-Windows-International-Core-WinPE\SetupUILanguage windowsPE 

Microsoft-Windows-
Setup\DiskConfiguration\Disk\CreatePartitions\CreatePartition 

Note: For this example, create 2 Partitions.  Windows Partition, and 
Data Partition. 

windowsPE 

Microsoft-Windows-
Setup\DiskConfiguration\Disk\ModifyPartitions\ModifyPartition 

Note: For this example, Modify 2 partitions.  Windows Partition and 

Data Partition 

windowsPE 

Microsoft-Windows-Setup\ImageInstall\OSImage\InstallTo windowsPE 

Microsoft-Windows-Setup\UserData windowsPE 

Microsoft-Windows-Shell-Setup\OOBE oobeSystem 

For more information on Windows 7 configuration passes: 

http://technet.microsoft.com/en-us/library/dd744341(WS.10).aspx 

 

All of the settings you added must appear in the Windows SIM Answer File pane. 

Under Settings, select the appropriate setting and, in the right-hand column, enter 

the appropriate value as specified in the following table. 
 

1 WindowsPE Microsoft-Windows-International-Core-WinPE InputLocale = en-US 

SystemLocale = en-US 

UILanguage = en-US 

UserLocale = en-US 

1 WindowsPE Microsoft-Windows-International-Core-
WinPE\SetupUILanguage 

UILanguage = en-US 

1 WindowsPE Microsoft-Windows-Setup\DiskConfiguration WillShowUI = OnError 

1 WindowsPE Microsoft-Windows-
Setup\DiskConfiguration\Disk 

DiskID = 0 

WillWipeDisk = true 

1 WindowsPE Microsoft-Windows-
Setup\DiskConfiguration\Disk\CreatePartitio

ns\CreatePartition 

Order = 1 

Size = 50000 

Type = Primary 

1 WindowsPE Microsoft-Windows-
Setup\DiskConfiguration\Disk\CreatePartitio

ns\CreatePartition 

Order = 2 

Extend=true 

Type = Primary 

  

http://technet.microsoft.com/en-us/library/dd744341(WS.10).aspx
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1 WindowsPE Microsoft-Windows-

Setup\DiskConfiguration\Disk\ModifyPartition

s\ModifyPartition 

Active = true 

Format = NTFS 

Label = Windows 

Order = 1 

PartitionID = 1 

1 WindowsPE Microsoft-Windows-
Setup\DiskConfiguration\Disk\ModifyPartition

s\ModifyPartition 

Format = NTFS 

Label = Data 

Order = 2 

PartitionID = 2 

1 WindowsPE Microsoft-Windows-
Setup\ImageInstall\OSImage 

InstallToAvailablePart

ition = false 

WillShowUI = OnError 

1 WindowsPE Microsoft-Windows-
Setup\ImageInstall\OSImage\InstallTo 

DiskID = 0 

PartitionID = 1 

1 WindowsPE Microsoft-Windows-Setup\UserData AcceptEula = true 

1 WindowsPE Microsoft-Windows-
Setup\UserData\ProductKey 

Key = <product key> 

WillShowUI = OnError 

7 oobeSystem Microsoft-Windows-Deployment\Reseal ForceShutdownNow = false 

Mode = Audit 

7 oobeSystem Microsoft-Windows-Shell-Setup\OOBE HideEULAPage = true 

ProtectYourPC = 3 

 

These settings outline a basic unattended installation in which no user input is required 

during Windows Setup.  When the installation is complete, the computer will reboot to 

audit mode.  Audit mode is a stage of Windows Setup that enables you to quickly boot 

to the desktop, install additional applications and device drivers, and test the 

installation.  Windows Welcome does not run in audit mode, but it will run the next 

time the computer restarts, once you have run the sysprep command with the /oobe 

option.  Windows Welcome, also called Machine OOBE (out-of-box experience), 

prompts the end user to read the Microsoft Software License Terms and to configure 

the computer.  

For more information about audit mode, see the Customize Windows in Audit Mode 

topic in the Windows Automated Installation Kit (Windows AIK) User's Guide 

(Waik.chm) or http://go.microsoft.com/fwlink/?LinkId=121506.  

For more information about Sysprep.exe, see the Sysprep Technical Reference topic in 

the Waik.chm or http://go.microsoft.com/fwlink/?LinkId=121713. 

 

9. Validate and Save Settings by In Windows SIM, click Tools, and then click 

Validate Answer File.  The setting values in the answer file are compared with 

the available settings in the Windows image. 

http://go.microsoft.com/fwlink/?LinkId=121506
http://go.microsoft.com/fwlink/?LinkId=121713
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10. If the answer file validates successfully, a “No warnings or errors” message 

appears in the Messages pane at the bottom of the Windows SIM window. 

Otherwise, error messages appear in the Messages pane. 

11. If an error occurs, double-click the error message in the Messages pane to 

navigate to the incorrect setting. Change the setting to fix the error, and then 

validate again by clicking Validate Answer File. Repeat this step until the answer 

file validates. 

12. On the File menu, click Save Answer File. Save the answer file as 

Autounattend.xml. 

13. Copy the Autounattend.xml file to the root directory of a USB flash drive. 

You now have a basic answer file that automates Windows Setup. For more 

information about building answer files, see the Phase 3: Preparing and Customizing 

Your Windows Image topic in the WAIK online help (waik.chm) or see the following 

website: http://go.microsoft.com/fwlink/?LinkId=121501. 

 

3.6.2.3 Create Base Image and Customize Image 

A reference computer is one that has a customized installation of Windows that you 

plan to duplicate onto one or more destination computers. In this section, you can 

create a reference installation by using the Windows product DVD and an answer file. 
 

1. Turn on the reference computer and insert the Windows 7 product DVD and the 

USB flash drive containing the answer file you created in the previous step 

(Autounattend.xml). 

Note: Ensure that your boot order shows CD, Hard drive, then USB devices.   
 

2. Restart the computer by pressing the CTRL+ALT+DEL keys. To boot from the 

CD/DVD-ROM disc, you may have to override the boot order. During initial boot, 

select the appropriate function key to override the boot order. 

Windows 7 Setup (Setup.exe) will begin automatically. By default, Windows Setup 

will search the root directory of all removable media for an answer file called 

Autounattend.xml. 

3. After Setup finishes, you can validate that all customizations were applied. For 

example, if you included the optional Microsoft-Windows-IE-InternetExplorer 

component and set the Home_Page setting in your answer file, you can verify it 

now by opening Internet Explorer. 

4. Once the Sysprep Preparation Tool window is displayed, prepare the sysprep 

machine before sysprepping machine. 

5. Click the X button at top right to close the dialog box. 

 

  

http://go.microsoft.com/fwlink/?LinkId=121501
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3.6.2.3.1 Building the Sysprep File 
 

On the Development PC, do the following: 
 

1. Navigate to the \Sources directory on your DVD-ROM drive and copy the 

Install.wim file from the Windows product DVD to a location on the computer. 

2. To open Windows SIM, click Start, click All Programs, click Microsoft Windows AIK, 

and then click Windows System Image Manager. 

3. On the Windows SIM File menu, click Select Windows Image. 

4. In the Select a Windows Image dialog box, navigate to the location where you 

saved Install.wim in step 1, and then click Open. 

You will be prompted to select an image. Choose the Windows image that you want 

to install, and then click OK. 

You will be prompted to create a catalog file. Click Yes to generate the file. 

If you are prompted to approve the program by a User Account Control window, 

you can select to allow the program or cancel the installation. 

5. On the File menu, click New Answer File. An empty answer file appears in the 

Answer File pane. 

6. In the Windows SIM Windows Image pane, expand the Components node to 

display available settings. If multiple Architectures are listed I.E., amd64, wow64, 

or x86, choose the one that matches the Windows 7 installation media. 

 

Component Configuration Pass 

Microsoft-Windows-Security-SPP 3 Generalize 

Microsoft-Windows-Deployment\ RunSynchronous\ 

RunSynchronousCommand 
4 Specialize 

Microsoft-Windows-Security-SPP-UX 4 Specialize 

Microsoft-Windows-Shell-Setup 4 Specialize 

Microsoft-Windows-International-Core 7 oobeSystem 

Microsoft-Windows-Shell-Setup 7 oobeSystem 

Microsoft-Windows-Shell-Setup\ AutoLogon 7 oobeSystem 

Microsoft-Windows-Shell-Setup\ 

FirstLogonCommands\ SynchronousCommand 
7 oobeSystem 

Microsoft-Windows-Shell-Setup\ 

FirstLogonCommands\ SynchronousCommand 
7 oobeSystem 

Microsoft-Windows-Shell-Setup\OOBE 7 oobeSystem 

Microsoft-Windows-Shell-Setup\UserAccounts 7 oobeSystem 
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Settings documented below. 
 

3 Generalize Microsoft-Windows-Security-SPP  SkipRearm=1 

4 Specialize Microsoft-Windows-Deployment\ RunSynchronous\ 

RunSynchronousCommand 
Order: 1 

path: net user administrator 

/active:yes 

WillReboot: Never  

4 Specialize Microsoft-Windows-Security-SPP-UX SkipAutoActivation: true 

4 Specialize Microsoft-Windows-Shell-Setup Computer Name: Leave blank 

(we will deal with this at the 

end) 

CopyProfile: true 

Product Key: <Product Key> 

Registered Organization: 

Microsoft (you must leave this 

in this section) 

Registered Owner: AutoBVT 

(you must leave this in this 

section) 

ShowWindowsLive: false 

TimeZone: Pacific Standard 

Time 

7 oobeSystem Microsoft-Windows-International-Core InputLocale: en-us 

SystemLocale: en-us 

UILanguage: en-us 

UserLocale: en-us  

7 oobeSystem Microsoft-Windows-Shell-Setup RegisteredOrganization: Your 

Company Name 

RegisteredOwner: Your Name 

7 oobeSystem Microsoft-Windows-Shell-Setup\ AutoLogon Enabled: true 

LogonCount: 5 

Username: administrator 

 

7 oobeSystem Microsoft-Windows-Shell-Setup\ AutoLogon\Password Value: <Administrator 

Password> 

7 oobeSystem Microsoft-Windows-Shell-Setup\ 

FirstLogonCommands\ SynchronousCommand 

CommandLine: cscript //b 

c:\windows\system32\slmgr.vb

s /ipk XXXXX-XXXXX-XXXXX-

XXXXX-XXXXX (windows 7 

license key) 

Order 1 

RequiresUserInput: false 

7 oobeSystem Microsoft-Windows-Shell-Setup\ 

FirstLogonCommands\ SynchronousCommand 

CommandLine: cscript //b 

c:\windows\system32\slmgr.vb

s /ato 

Order 2 

RequiresUserInput: false 
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7 oobeSystem Microsoft-Windows-Shell-Setup\OOBE HideEULAPage: true 

NetworkLocation: Home 

ProtectYourPC: 1 

7 oobeSystem Microsoft-Windows-Shell-Setup\UserAccounts\ 

AdministratorPassword 

Value: <Administrator 

Password> 

 

7 oobeSystem Microsoft-Windows-Shell-

Setup\UserAccounts\LocalAccounts\ 

Right Click LocalAccounts and 

choose Insert New 

LocalAccount. 

7 oobeSystem Microsoft-Windows-Shell-

Setup\UserAccounts\LocalAccounts\LocalAccount 

Action: AddListItem 

Description: Local 

Administrator 

DisplayName: Administrator 

Group: Administrators 

Name: Administrator 

7 oobeSystem Microsoft-Windows-Shell-

Setup\UserAccounts\LocalAccounts\LocalAccount\Pas

sword 

Value: <Administrator 

Password> 

 

7. Save File sysprep.xml. 

 

3.6.2.4 Sysprep Image 
 

On the Reference PC, perform the following steps: 
 

1. Once the sysprep.xml file is created, prepare the image machine by installing any 

software/drivers, make any profile customizations, etc.  At a minimum, ensure LAN 

drivers are included in this process.  This will ensure other software may be 

downloaded after an initial reimage. 

2. If you need to reboot, the computer will boot you back into the Administrator 

account.  You will be stuck in this audit mode until you run sysprep with the /oobe 

parameter.  After doing so, sysprep will delete/clean up the Administrator account, 

but if you have copyprofile=true in your unattended answer file, it will copy the 

customized Admin account to the default profile before deleting it. 

3. Create a cmd file SetupComplete.cmd under c:\windows\setup\scripts directory. 

4. Edit the file in Notepad and insert the following line: del /Q /F 

c:\windows\system32\sysprep\sysprep.xml 

5. Copy sysprep.xml file created above to C:\windows\system32\sysprep. 

6. Open a command prompt as administrator and navigate to 

c:\windows\system32\sysprep. 

7. Ensure the Sysprep Tool Dialog box is closed. 

8. Run the following command line: sysprep /generalize /oobe /shutdown 

/unattend:sysprep.xml and close command dialog box after execution 

9. Open the CD tray and remove the Window 7 install DVD if needed. 
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10. System will shut down once Sysprep completes. 

 

3.6.3 Create the Recovery OS 
 

3.6.3.1 Gather Required Files 

On the Development PC, download the following: 

 

Included with this document is a tool called ISO_Builder.  Copy it to the folder to 

c:\ISO_builder. 

 

 

Windows Automated Install Kit: 

http://www.microsoft.com/download/en/details.aspx?id=5753 

Save to: C:\iso_builder\src\KB3AIK_EN.iso 

Note: this was previously downloaded above. 

 

WAIK for Windows 7 Supplement English 

http://www.microsoft.com/download/en/details.aspx?id=5188 

Save to: C:\iso_builder\src\waik_supplement_en-us.iso 

 

 

  

http://www.microsoft.com/download/en/details.aspx?id=5753
http://www.microsoft.com/download/en/details.aspx?id=5188
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3.6.3.2 Use ISO Builder to Create the Recovery OS 

First, create a test recovery OS. This is used for testing and for capturing the OS 

image to the desired share. 

1. Double-click c:\iso_builder\iso_builder.vbs. 

2. If prompted, click Yes to the User Access Control Message. 

3. If any of the required files are shown with a red line to the left (as shown in  

Figure 1 below), they cannot be found. These files should have been downloaded in 

section 3.6.2.1 above. Verify the downloads and saved locations. 

 

Figure 1:  ISO Builder is Ready for Use 
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Configure ISO Builder settings as follows (

 

4. Figure 2): 

 2 stage boot : Not Selected 

 Serial Over LAN Driver and Support. : Selected 

 RealVNC VNC Free Edition – Server : Not Selected 

 Use Case : Select OS Image 

 ISO Image File Name : OS_Image_Manual.iso 
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Figure 2:  ISO Builder Settings 

5. Click Save. 

6. Under OS Image, click Settings. 
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7. Set as follows (Figure 3): 

 Capture or Apply : Choose on Boot 

 All other fields may be left blank. Any blank field will be prompted for after the 

Recovery OS boots. 

 

Figure 3:  Settings Screen 

8. Click Save. 

9. Click Close. 
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10. On the main ISO Builder screen, click Build ISO. At this point, ISO Builder will 

create an ISO file.  A log is shown under the tool’s buttons.  If there is an error, 

check the log.  Also, the log may be made more verbose by selecting Verbose Log 

prior to clicking Build ISO. 

 

Figure 4:  ISO Builder Builds the ISO File 

11. When the process completes, the form returns and the ISO image may be found in 

c:\ISO_Builder\OS_Image_Manual.iso.  This is your recovery OS. 
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3.6.4 Capture the Fresh OS Image to the Share 
1. Burn the OS_Image_Manual.iso file to a CD. 

2. Turn on the reference computer, insert the CD you created in the previous step, 

and perform actions required to boot the PC from the CD. 

Note: do NOT allow the PC to boot to its hard disk. Otherwise the Sysprep seal will 

be broken and you will have to perform the sysprep steps again. 

After the PC boots, you are prompted with the OS Image settings page: 

 

Figure 5:  OS Image Settings Page 

3. Set as follows: 

Capture or Apply : Capture 

UNC Path to Image: \\<name or IP of the Help Desk Console> 

\OS_Image\Win7.wim  

(Note: at this point you are naming your image file. In this example, it will be 

named Win7.wim. If you would like it in a sub directory you can add directory 

names into the path. Folders will be created if they do not exist.) 

User Name: OSCapture 

Domain: <name or IP of the Help Desk Console> 

Password: <Password you assigned> (In the lab example, we use P@ssw0rd). 

4. Click Save and Run. The OS image will be created and saved on the network 

share. 

5. When completed, click OK to the reboot prompt. 

6. Type exit <return> at the command prompt to reboot the PC. Or, just power the 

PC off. 
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3.6.5 Setup the Service Desk Console 

3.6.5.1 Gather and Install Required Files 

On the Service Desk Console PC, do the following: 
 

1. Copy OS_Image_Manual.iso to c:\ISOs\. 

 

RealVNC VNC Viewer Plus is used to monitor the Reimage Process. Although not 

covered in this document, you may use alternate KVM Remote Control software for 

this purpose. 

 

2. Download and install RealVNC’s VNC Viewer Plus: 

http://www.realvnc.com/products/viewerplus/index.html  

 

RIL is used to perform the IDE Redirection process. It also provides automation 

support. Although not covered, other IDE-R capable software may be used.  

 

3. Download Remote ISO Launcher (RIL): 

http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20961&lang=

eng&OSVersion=&DownloadType= . 

4. Extract the RIL files to c:\RIL. 

5. Launch RIL by double clicking on c:\RIL\RemoteISOLauncher.exe. 

6. Click the CD icon. 

 

Figure 6:  CD Icon on RIL Interface 

http://www.realvnc.com/products/viewerplus/index.html
http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20961&lang=eng&OSVersion=&DownloadType
http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20961&lang=eng&OSVersion=&DownloadType
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7. Type in a friendly name such as “OS Reimage”. 

8. Click Browse. 

9. Select c:\ISOs\OS_Image_Manual.iso. 

10. Click Open. 

11. Check the box titled “Reset boot path after launch”. 

12. Click Optionally select a color for the button. 

13. Click Save. 

14. Close RIL, and save settings when prompted. 

15. Optionally create a desktop shortcut to c:\RIL\RemoteISOLauncher.exe. 

 

3.6.6 Perform a Remote OS Reimage 
 

1. Open VNC Viewer Plus. 

2. Enter the IP address of the remotely managed Intel vPro technology based system. 

3. Set Connection mode to Intel AMT. 

4. Set Encryption to None. 

5. Click Connect. 

6. Click Yes to “Is <computer> the expected fully-qualified domain name of <ip>”? 

7. Enter your Intel AMT Admin credentials and click OK. 

8. Enter a User Consent Code if prompted. 

9. You can now interact remotely with the managed PC. 

10. Open RIL. 

11. In the host name, enter the IP address or FQDN. 

12. Select the Settings tab. 

13. Enter authentication for username and password to Intel AMT. 

14. Select the Launch tab. 

15. Click the OS Reimage button in the boot image section. 

16. Click OK to the warning (“Warning, you are about to reboot the remote machine.  

If the remote user has any unsaved work it may be lost.”). 

17. The managed client reboots to the Recovery OS. 
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18. Upon completion, the managed PC shows the OS Image settings screen (below). 

Using VNC Viewer Plus, interaction is performed remotely. Note: if the VNC 

session has timed out, simply reconnect. 

 

Figure 7:  OS Image Settings Screen 

19. Set as follows: 

 Capture or Apply : Apply 

 UNC Path to Image: \\<name or IP of the Help Desk 

Console>\OS_Image\Win7.wim  

 User Name: OSDeploy 

 Domain: <name or IP of the Help Desk Console> 

 Password: <Password you assigned>. (For lab use, we use P@ssw0rd). 

 Warn Before Formatting: <as desired>. Note: this will cause a prompt just 

prior to performing the hard drive repartition and format. This gives a last 

chance to opt out before any data on the drive is erased.  

 Force Hard Drive Repartition: <as desired>. Note: If the hard disk has a 

primary partition named Windows and a Secondary partition named Data, the 

default action is to leave the Data partition intact. Setting this option to Yes will 

cause the Data partition to be recreated. 

 Partition Size: <as desired>. Note: This is the size of the first partition 

(Windows). The second partition (Data) uses the remaining space on the drive. 

Note: if this is set to All, a second partition is not created. 

20. Click Save and Run. 

 

At this point, the managed PC will apply the fresh OS image located at the UNC path 

listed above.  This includes (re)partitioning and formatting the hard drive and applying 

boot loader files.  Upon completion, the PC will reboot and continue with the 
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Windows 7 out of box experience process.  Interact with this process and perform and 

customization remotely through RealVNC VNC Viewer Plus as needed.  Specific steps 

are not provided. 

 

 

3.6.7 Other Recommendations 

This section provides alternative methods that may be helpful in improving solution 

performance. 

3.6.7.1 Presetting the Recovery OS 

Up to now, the recovery OS has asked for settings once it finished booting.  It is 

possible to preset these settings during the ISO build process.  Follow steps in section 

3.6.3.2 to view these settings.  As long as all settings are filled in, the Recovery OS 

will not prompt for settings.  There are a couple considerations.  

First, the credentials for OS Reimaging, including the password, are stored in clear text 

in the ISO Builder settings files and in the Recovery OS itself.  In order to limit 

vulnerability, it is recommended that this user account have read only access to the 

OS_image share, and no other access.  This way, if the credentials are compromised, 

the only compromised files are those stored in the OS_Image share.  Another option is 

to fill all information except the user credentials.  Then during use the Service Desk 

Technician can enter the credentials.  In this way the credentials are not stored.  

However, all Service Desk Technicians who will use the account must know these 

credentials. 

Another consideration is the Warn Before Formatting option.  If this is set to Yes, the 

Recovery OS will prompt before formatting.  Thus, the process will require interaction, 

despite having all values set. 

 

3.6.7.2 Two Stage Boot 

When possible, it is recommended to use two stage boot to speed the loading of the 

recovery OS.  Two stage boot works by using an intermediary boot image.  This image 

is very small and thus, boots quickly. Once this image is loaded, it handles booting of 

the recovery OS.  The recovery OS can then be located on the managed PC’s hard 

drive or on a nearby network share.  This decreases overall boot time, speeding time 

to repair. 

More information on Two stage boot can be downloaded here: 

http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20960&lang=eng

&OSVersion=&DownloadType=  

The following sections contain “quick start” steps to try two stage boot. 

 

  

http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20960&lang=eng&OSVersion=&DownloadType
http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20960&lang=eng&OSVersion=&DownloadType
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3.6.7.2.1 Two stage boot setup 

On the Development PC, do the following: 

1. Launch c:\iso_builder\iso_builder.vbs. 

2. Select 2 stage boot. 

3. Click Settings. 

4. Complete the form as follows (shown in Figure 8 below). 

 Try Local Hard Drive: Yes 

 Image: OS_Image_Manual.iso 

 Try Network Resource: Yes 

 Take input from: KVM Session 

 Download Type: Share Drive 

 Username: OSImage 

 Password: <Password you assigned above> 

 Domain: <IP or name of Service Desk PC> 

 Path: <IP or name of Service Desk PC>\os_image 

 Image: OS_Image_Manual.iso 

 

Figure 8:  ISO Builder Settings for Two Stage Boot 

5. Click Save Settings. 

6. Click Close. 

7. In ISO Builder, click Build ISO. 

 

Upon completion there are now two .iso files, OS_Image_Manual.iso, and 

ifast_OS_Image_Manual.iso.  The second one is the 2 stage boot image.  
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1. Copy OS_Image_Manual.iso to c:\OS_Image\ on the Service Desk Console PC. 

2. Copy OS_Image_Manual.iso to d:\ on the managed PC.  

3. Copy ifast_OS_Image_Manual.iso to c:\ISOs\ on the Service Desk PC.  

4. Reboot the managed PC via Windows Start menu after the copy is complete. 

 

On the Service Desk PC, add a new button in RIL as outlined above.  Name the button 

“OS Image via 2 Stage” and use c:\ISOs\ifast_OS_Image_Manual.iso as the target 

ISO image. 

 

3.6.7.2.2 Using Two Stage Boot 
 

Local Boot Option 

On the Service Desk PC, in Remote ISO Launcher, do the following: 

1. Enter the IP address for the managed PC.  

2. Click OS Reimage via 2 Stage. 

The managed PC will boot the two stage boot ISO image.  The image will scan the 

managed PC’s hard drive for OS_Image_Manual.iso.  Since it was placed there in the 

steps above, it will be found and booted.  Note that if the image is not found, the 

network boot option will be tried next. 
 

Network boot option 

On the managed PC, do the following: 

1. If needed, reboot the managed PC to Windows 7. 

2. Delete d:\OS_Image_Manual.iso. When the delete is finished, reboot the managed 

PC via the Windows start menu. 

On the Service Desk PC, in Remote ISO Launcher, do the following: 

1. Enter the IP address for the managed PC.  

2. Click OS Reimage via 2 Stage. 

The managed PC will boot the two stage ISO image. The image will scan the managed 

PC’s hard drive for OS_Image_Manual.iso. Since it was just deleted, it will not be 

found. Two stage boot will then boot a small Linux OS. This OS will map to the OS 

Image share, download OS_Image_Manual.iso to RAM, and reboot to 

OS_Image_Manual.iso. 

 

3.6.7.3 Customize the OS Image 

The instructions included here are generic.  Each environment is different, with its own 

needs.  By customizing the OS image to suite your needs up front, manual steps at OS 

reimage time are reduced.  For example, install drivers and applications during steps 

in section 3.6.2.4.  Other options include adding scripts to the image to do things like 

join an active directory domain. 
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3.6.7.4 OS_Image Share at network edge 

The OS Image is a large file. To decrease the time needed to apply the image, it 

should be stored at the network edge.  This may be accomplished via DFS, or other 

means.  Steps are not provided by this document.  Rather, this is called out so it will 

considered during planning for a final deployment. 

 

  



Intel® vPro™ Technology Solution Reference Design 

   35 

4 Windows Deployment Services 

This section provides instructions on performing a remote OS re-image using Windows 

Deployment Services (WDS).  

4.1 Overview 

Windows Deployment Services (WDS) provides an easy method for managing and 

deploying OS images from a remote network location using PXE boot as a starting 

point.  This allows for bare metal OS installs, as well as re-installs over the top of 

existing hard drives.  WDS can also be incorporated with Microsoft Deployment Toolkit 

(MDT), and other OS deployment tools for added functionality.  See WDS 

documentation for more details on WDS. 

Intel vPro technology based systems can be used to perform a Windows install 

remotely. Below are basic steps to accomplish this use case.  This includes a basic 

installation and setup of WDS for a Lite Touch OS Deployment, setting up a help desk 

console, and performing this use case.  The section concludes with discussion of 

deploying this into a production environment.  

NOTE 

This does not include backup up user data, installing OSs, customizing an installed OS, 

etc. While all this is possible, it is outside the scope of this document. See WDS 

documentation for more details. 

http://technet.microsoft.com/en-us/library/cc772106(WS.10).aspx 

 

  

http://technet.microsoft.com/en-us/library/cc772106(WS.10).aspx
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4.2 Requirements 

 

Network with 
DHCP Server 

Document uses Windows 2008 R2 server 

Active Directory Document uses Windows 2008 R2 server 

WDS Document uses Windows 2008 R2 server 

Service Desk 
Console 

 Any PC with Microsoft Windows 7. 

PC used by the Service Desk technician to remotely control the Knowledge 

Workers PC in the use case. 

Managed Client 
with Intel vPro 
technology 

 Intel AMT 6.0 or higher 

 Intel Integrated Graphics 

 Configured for non-TLS and Digest credentials.  

This PC will have its OS reimaged during this use case. 

Note: Depending on your WDS setup, all data in this system will be 
erased. Use a non-critical system with non-critical data. 

Note: Kerberos credentials are supported but not shown in this 
document. 

 

 

4.3 Set Up WDS 

The following steps are derived from the WDS Documentation, and provided as a 

means of quickly getting up and running.  Please refer to the WDS quick start guide for 

more details: http://technet.microsoft.com/en-us/library/cc771670(WS.10).aspx 

These steps were written using Windows Server 2008R2 Enterprise 64 bit. Adjust as 

needed for your specific configuration. 

 

4.3.1 Gather Required Supporting Files 

On the WDS Server, do the following: 

Win7 DVD 

Locate a Windows 7 installation DVD.  It will be required for subsequent steps.  

 

WAIK 

On the WDS Server, click the link below to obtain the Windows Automated Installation 

Kit for Windows 7. 

http://www.microsoft.com/download/en/details.aspx?id=5753 

This results in an .iso file. Mount this .iso file (we suggest using Virtual CloneDrive for 

mounting .iso files) or burn it to a DVD and insert the DVD. 

http://technet.microsoft.com/en-us/library/cc771670(WS.10).aspx
http://www.microsoft.com/download/en/details.aspx?id=5753
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Install the WAIK with default options (select Windows AIK Setup from the CD’s 

default GUI menu). 

 

WAIK SP1 

Note, if you do not have a DVD with SP1, skip steps for installing WAIK SP1. 

Download the WAIK for Windows 7 Supplement English 

http://www.microsoft.com/download/en/details.aspx?id=5188 

This results in an .iso file. Mount this .iso file (we suggest using Virtual CloneDrive for 

mounting .iso files) or burn it to a DVD and insert the DVD. 

Open a command prompt as administrator and run xcopy <drive>:\ "C:\Program 

Files\Windows AIK\Tools\PETools" /ERDY, where <drive>: is the drive letter 

representing WAIK SP1. 

 

4.3.2 Install WDS 

On WDS server, do the following: 
 

1. Ensure the service is joined to the domain. 

2. Click Start –> Programs -> Administrative Tools -> Server Manager. 

3. Expand Server Manger -> Roles and select Roles. 

4. Click Add Roles. 

5. On the Before You Begin screen click Next. 

6. Select Windows Deployment Services and click Next. 

7. On the Overview of Windows Deployment Services click Next. 

8. On the Select Role Services screen click Next. 

9. On the Confirm Installation Selections screen click Install. 

10. On the Installation Results screen click Close. 

11. Close the Server Manager Window. 

 

4.3.3 Configure WDS 

On WDS Server, do the following: 

1. Click Start -> Programs -> Administrative Tools -> Windows Deployment Services. 

2. Expand the Windows Deployment Services -> Servers -> <Your WDS Server> tree 

and select <Your WDS Server>. 

3. Right-click <Your WDS Server> and select Configure Server. 

4. On the Before You Begin screen, ensure the requirements listed are met. Then click 

Next. 

5. On the Remote Installation Folder Location screen, leave defaults and click Next. 

6. If a “System Volume Warning” appears, click Yes. 

7. On the PXE Server Initial Settings screen, select Respond to all client 

computers (known and unknown) and click Next. 

8. Deselect Add Images to the server now and click Finish. 

http://www.microsoft.com/download/en/details.aspx?id=5188
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4.3.4 Add OS Image 

On WDS Sever, do the following: 

1. Insert your Windows 7 DVD into the WD Server. 

2. On the Windows Deployment Services screen, expand Windows Deployment 

Services -> Servers -> <Your WDS Server> -> Install Images. 

3. Right-click Install Images and select Add Install Image. 

4. On the Image Group screen, click Next. 

5. On the File Location screen, enter <drive>:\sources\install.wim where 

<drive>: is the drive representing the Windows 7 DVD. 

6. On the Available Images screen, click Next. 

7. On the Summary screen, click Next. 

8. When the task completes, click Finish. 

 

4.3.5 Add Boot Image 

On WDS Sever, do the following: 

1. Insert your Windows 7 DVD into the WD Server. 

2. In Windows Deployment Services window, expand Windows Deployment Services -

> Servers -> <Your WDS Server> -> Boot Images. 

3. Right-click Boot Images and select Add Boot Image. 

4. On the File Location screen, enter <drive>:\sources\boot.wim where <drive>: 

is the drive representing the Windows 7 DVD. 

5. On the Image Metadata screen, click Next. 

6. On the Summary screen, click Next. 

7. When the task completes, click Finish. 

4.3.6 Add Drivers 

The WDS manages drivers for the target systems. As such, any drivers may be added. 

However, the LAN and MEI drivers are required for WDS to be successful. On the 

Server running WDS. 
 

1. Copy the LAN Driver pack and MEI Driver pack from this UCRD’s download file to 

c:\drivers\. 

2. In the Windows Deployment Services window, expand Windows Deployment 

Services -> Servers -> <your WDS Server> -> drivers. 

3. Right-click Drivers and select Add Driver Package. 

4. Click Browse. 

5. Browse to c:\drivers\LAN\PRO1000\Win32\NDIS62 and select e1c6232.inf. 

6. In the remaining screens, click Next to accept defaults; click Finish in the final 

screen. 
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7. Repeat steps 4– 6 for the following: 

c:\drivers\LAN\PRO1000\Win32\NDIS62\e1k6232.inf 

c:\drivers\LAN\PRO1000\Winx64\NDIS62\e1c62x64.inf 

c:\drivers\LAN\PRO1000\Winx64\NDIS62\e1k62x64.inf 

c:\drivers\MEI\8\MEI\heci.inf 

c:\drivers\MEI\7\MEI\heci.inf 

c:\drivers\MEI\6\MEI\heci.inf 

8. Click Boot Images in the navigation tree. 

9. Right-click the boot image added above and choose Add Driver Package to 

Image. 

10. Click Next. 

11. Click Search for Packages. 

12. If your image is a 32 bit image, deselect all but the following: 

e1c6232.inf 

e1k6232.inf 

heci.inf (all instances) 

13. If your image is a 64 bit image, deselect all but the following: 

e1c62x64.inf 

e1k62x64.inf 

heci.inf (all instances) 

14. Click Next, then click Next again. 

15. Wait for the process to complete and click Finish.  
 

The WDS boot image now contains LAN drivers for Intel vPro systems with Intel AMT 6 

and 7. 

 

4.3.7 Configure DHCP Server 

PXE works by booting to the server and image file listed in DHCP options 66 and 67 

respectively. The following instructions step through this configuration for a DHCP 

Server in Windows 2008R2. Adjust these steps based on your DHCP server. 

On the DHCP Server, do the following: 

1. Click Start -> Programs -> Administrative tools -> DHCP. 

2. Expand DCHP -> <your DHCP Server> -> IPv4 -> <scope vPro is using> -> Scope 

Options. 

3. Right-click Scope Options and select Configure Options. 

4. In the General tab, scroll down to and select 066 Boot Server Host Name. For 

String Value set the FQDN of your WDS Server. 

5. In the General tab, scroll down and select 067 Boot File Name. For String Value 

enter boot\x86\wdsnbp.com. 

6. Click OK. 
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At this point WDS is ready to perform OS Deployments that are initiated locally by 

booting to PXE. See WDS documentation for more details. 

 

4.3.8 Create an WDSUnattend.xml for a basic unattended install 

NOTE 

This step is not strictly required.  However, it will further automate the install of 

Windows 7, including hard disk partitioning.  If you skip this step, it is highly 

recommended that Windows be installed to the first partition of the hard disk.  If it is 

not installed to the first partition, the “use data backup” task sequence in the MDT 

section will not work. 

 

1. Insert the Windows 7 SP1 installation DVD used above. 

2. To open Windows SIM, click Start, click All Programs, click Microsoft Windows AIK, 

and then click Windows System Image Manager. 

3. On the Windows SIM File menu, click Select Windows Image. 

4. In the Select a Windows Image dialog box, navigate to <DVD 

drive>:\sources\Install.wim, and then click Open. 

You will be prompted to select an image. Choose the Windows image that you want 

to install, and then click OK. 

You will be prompted to create a catalog file. Click Yes to generate the file. 

If you are prompted to approve the program by a User Account Control window, 

you can select to allow the program or cancel the installation. 

5. On the File menu, click New Answer File. An empty answer file appears in the 

Answer File pane. 

6. In the Windows SIM Windows Image pane, expand the Components node to 

display available settings. 

7. On the expanded list of components, add the components in the table below to 

your answer file by right-clicking the component, and then selecting the 

appropriate configuration pass. This action adds the component to your answer file 

in the specified configuration pass, or phase, of Windows installation.  
 

Component Configuration pass 

Microsoft-Windows-International-Core-WinPE\SetupUILanguage windowsPE 

Microsoft-Windows-
Setup\DiskConfiguration\Disk\CreatePartitions\CreatePartition 

windowsPE 

Microsoft-Windows-
Setup\DiskConfiguration\Disk\ModifyPartitions\ModifyPartition 

windowsPE 

Microsoft-Windows-
Setup\WindowsDeploymentServices\ImageSelection\InstallTo 

windowsPE 

For more information on Windows 7 configuration passes: 

http://technet.microsoft.com/en-us/library/dd744341(WS.10).aspx 

http://technet.microsoft.com/en-us/library/dd744341(WS.10).aspx
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8. All of the settings you added must appear in the Windows SIM Answer File pane. 

In the far right pane, under Settings, select the appropriate setting and, in the 

right-hand column, enter the appropriate value as specified in the following table. 
 

1 WindowsPE Microsoft-Windows-International-Core-WinPE InputLocale = en-US 

SystemLocale = en-US 

UILanguage = en-US 

UserLocale = en-US 

1 WindowsPE Microsoft-Windows-International-Core-
WinPE\SetupUILanguage 

UILanguage = en-US 

1 WindowsPE Microsoft-Windows-Setup\DiskConfiguration WillShowUI = OnError 

1 WindowsPE Microsoft-Windows-

Setup\DiskConfiguration\Disk 
DiskID = 0 

WillWipeDisk = true 

1 WindowsPE Microsoft-Windows-
Setup\DiskConfiguration\Disk\CreatePartitio

ns\CreatePartition 

Order = 1 

Extend = true 

Type = Primary 

1 WindowsPE Microsoft-Windows-
Setup\DiskConfiguration\Disk\ModifyPartition
s\ModifyPartition 

Active = true 

Format = NTFS 

Label = Windows 

Order = 1 

PartitionID = 1 

1 WindowsPE Microsoft-Windows-
Setup\WindowsDeploymentServices\InstallT

o 

DiskID = 0 

PartitionID = 1 

 

These settings outline a basic WDS unattended installation, including hard disk 

partitioning. Optionally, other settings may be added. See 

http://technet.microsoft.com/en-us/library/cc771830(WS.10).aspx for more details. 

 

1. Validate and Save Settings by In Windows SIM, click Tools, and then click 

Validate Answer File.  The setting values in the answer file are compared with 

the available settings in the Windows image. 

2. If the answer file validates successfully, a “No warnings or errors” message 

appears in the Messages pane at the bottom of the Windows SIM window. 

Otherwise, error messages appear in the Messages pane. 

3. If an error occurs, double-click the error message in the Messages pane to 

navigate to the incorrect setting. Change the setting to fix the error, and then 

validate again by clicking Validate Answer File. Repeat this step until the answer 

file validates. 

4. On the File menu, click Save Answer File.  Save the answer file as 

c:\RemoteInstall\WdsClientUnattend\WDSunattend.xml. 

http://technet.microsoft.com/en-us/library/cc771830(WS.10).aspx
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You now have a basic answer file that automates Windows Setup from WDS. Now 

configure WDS to use it. 

1. In the Windows Deployment Services window, expand Windows Deployment 

Services -> Servers -> <your WDS Server>. 

2. Right-click on the WDS server and choose Properties. 

3. Click the Client tab. 

4. Select Enable unattended installation. 

5. In the row matching the Windows 7 DVD architecture click Browse… 

6. Navigate to c:\RemoteInstall\WdsClientUnattend\WDSunattend.xml and click 

Open. 

7. Click OK. 

4.4 Remote OS Image from the Service Desk Console 

At this point WDS is ready to perform OS Deployments that are initiated locally by 

booting to PXE.  However, this use case is about performing the OS Deployment 

remotely.  These steps get the service desk console ready for that task. 

There are two alternative methods to start the process remotely. The first uses Intel 

vPro technology’s KVM Remote Control feature to initiate a PXE boot.  The second uses 

WDS Discovery Media with Intel vPro technology’s IDE Redirection. 

NOTE 

Before proceeding, decide whether you wish to perform method 1, KVM Remote 

Control and PXE boot (section 4.4.1) or method 2, WDS Discovery Media with IDE-R 

(section 4.4.3). 

4.4.1 Method 1 Overview– KVM Remote Control and PXE Boot 

The following high level steps are described in detail in section 0 below. 

1. Install RealVNC VNC Viewer Plus. 

2. Connect to the managed client PC. 

3. Reboot the managed client PC. 

4. Press BIOS keys required to trigger a PXE boot. 

5. Press F12 to trigger WDS. 

6. Interact with WDS’s OS install process via KVM Remote Control. 
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4.4.2 Perform Method 1 

On the Service Desk Console, do the following: 

If needed, install RealVNC VNC Viewer Plus: 

http://www.realvnc.com/products/viewerplus/index.html 

 

1. Open VNC Viewer Plus. 

2. These steps are optional. They will prevent the VNC session from timing out. 

 Click Options. 

 Click Advanced. 

 Select the Expert tab. 

 Set AMTSessionTimeout to 0. 

 Click OK. 

3. Enter the IP address of the remotely managed client PC. 

4. Set Connection mode to Intel AMT. 

5. Set Encryption to None. 

6. Click Connect. 

7. If prompted, Click Yes to “Is <computer> the expected fully-qualified domain 

name of <ip>”? 

8. Enter your Intel AMT Admin credentials and click OK. 

9. Enter a User Consent Code if prompted. 

10. You can now interact remotely with the managed PC. 

11. Move the mouse to the top center of the window. A menu will drop down. 

12. Click the Power button (red circle). 

13. Click Reset. 

14. With Boot to OS selected, click Reset. 

15. As the managed client PC goes through BIOS post, press key strokes to trigger a 

network boot. These key strokes vary by system. Check with system 

documentation for details. Here are two examples: 
 

On a Lenovo T420: 

o Press <Enter> 

o When a boot menu appears, press F12 to select a temporary boot device 

o From the Boot menu, select PCI LAN: IBA… and press <Enter> 
 

On an Intel DQ67EP motherboard: 

o Press F12 for network boot 
 

Note: If network boot is not listed, it must be enabled in BIOS. This can also be 

performed from the KVM Remote Control session. See the system vendor’s 

documentation for the steps required to perform this action. 
 

16. As WDS boots, it will prompt to “Press F12 for network boot”. Press F12 now. 

17. If prompted, select the boot image added above.  

 

http://www.realvnc.com/products/viewerplus/index.html


Intel® vPro™ Technology Solution Reference Design 

44  

From here, the managed client PC will boot the WDS boot image.  Since KVM Remote 

Control is connected, any required interaction can take place remotely.  Any 

automation provided with WDSUnattend.xml will take place automatically. 

 

NOTE 

By default, Windows 7 installs with a 100 MB partition for recovery operations.  This 

partition makes remote deployment and recovery more challenging.  Specifically, this 

will cause the Microsoft Deployment Toolkit task sequence for User Data Back to fail.  

If you did not use the WDSUnattend.xml file above, avoid the 100 MB partition do the 

following: 

1. When booted to WDS media press <Shift> - <F10> at the same time. 

2. A command prompt opens. 

3. Use diskpart to create and format a single partition that fills the hard drive. 

4. Type exit to close the command prompt 

5. Continue with WDS install and install to the partition created above. 

 

4.4.3 Method 2 Overview – WDS Discovery Media with IDE-R 

The following high level steps are described in detail in section 4.4.4 below. 

1. Create Discovery Media. 

2. Install RealVNC VNC Viewer Plus, RIL, and 2 stage boot. 

3. Connect to the managed client PC. 

4. Reboot the managed client PC to Discovery Media. 

5. Interact with WDS’s OS install process via KVM Remote Control. 

4.4.4 Perform Method 2  

4.4.4.1 Setup a share for 2 stage 

Now create a share to store the Discovery Media. This is used by the 2 stage boot 

process to boot the media remotely. 

1. Create a folder c:\2stage. 

2. Right-click and choose Share with specific people. Be sure an administrator 

account has at least read access and click Share.  

3. When complete, click Done. 

NOTE 

Discovery Media can be placed on any share, a web server, or even the managed 

client system’s local hard drive for use with 2 stage boot.  See 2 stage boot 

documentation for details. 

  



Intel® vPro™ Technology Solution Reference Design 

   45 

4.4.4.2 Create the discovery media 

On the Server with WDS, do the following: 

1. Click Start -> Programs -> Administrative Tools -> Windows Deployment Services. 

2. Expand Windows Deployment Services -> Servers -> <your WDS Server> -> Boot 

Images. 

3. Right-click the boot image added above and click Create Discover Image. 

4. In Location and file name, enter c:\discover.wim. In the WDS Server field, enter 

the IP address or FQDN of your WDS server. Click Next. 

5. When the process completes, click Finish. 

NOTE 

The following steps use the WAIK, as installed above. 
 

6. Right-click Start –> Programs -> Microsoft Windows AIK -> Deployment Tools 

Command Prompt and select Run as Administrator. 

7. If your Windows 7 SP1 DVD is 32 bit, execute the following command: 

copype.cmd x86 c:\winpe\ 

8. If your Windows 7 SP1 DVD is 64 bit, execute the following command: 

copype.cmd amd64 c:\winpe\ 

9. Execute the following commands: 

copy /y c:\discover.wim c:\winpe\iso\sources\boot.wim 

del /f c:\winpe\iso\boot\bootfix.bin  

Note: removing this file removes the “Press Any Key to Continue” message. 

oscdimg –n –bc:\winpe\etfsboot.com c:\winpe\iso c:\2stage\discover.iso 

 

 

4.4.4.3 Set Up the Service Desk Console 

RealVNC VNC Viewer Plus is used to monitor the Reimage Process. Although not 

covered in this document, you may use alternate KVM Remote Control software for 

this purpose. 

2 stage boot is used to speed the remote booting process.  

Remote ISO Launcher (RIL) is used to perform the IDE Redirection process. It also 

provides automation support.  

 

On the Service Desk Console, install VNC Viewer Plus, 2 Stage Boot, and RIL by 

performing the following steps: 
 

1. Download and install RealVNC’s VNC Viewer Plus: 

http://www.realvnc.com/products/viewerplus/index.html  

http://www.realvnc.com/products/viewerplus/index.html
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2. Download the 2 Stage Boot software and documentation from 

http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20960&lang=

eng&OSVersion=&DownloadType=  

3. Extract to c:\ifast. 

4. Run c:\ifast\ifast.hta. 

5. Complete the form as desired.  This document uses: 

 Try Local Hard Drive: No 

 Try Network Resource: Yes 

 Take Input From: KVM Session 

 Download Type: Share Drive 

 Username: <itproadmin> 

 Password: <P@ssw0rd> 

 Domain: <IP of WDS> 

 Path: \\<IP of WDS>\2stage 

 Image: discovery.iso  

6. Click Save. 

7. Click Build ISO. The file c:\ifast\ifast.iso is created. 

8. Download Remote ISO Launcher (RIL): 

http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20961&lang=

eng&OSVersion=&DownloadType=.  

9. Extract the RIL files to c:\RIL. 

10. Launch RIL by double clicking on c:\RIL\RemoteISOLauncher.exe. 

11. Click the CD icon as shown below. 

 

Figure 9:  CD Icon on RIL Interface 

12. Type in a friendly name such as “OS Reimage”. 

http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20960&lang=eng&OSVersion=&DownloadType
http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20960&lang=eng&OSVersion=&DownloadType
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13. Click Browse. 

14. Select c:\ifast\ifast.iso. 

15. Click Open. 

16. Check the box titled “Reset boot path after launch”. 

17. Click Optionally select a color for the button. 

18. Click Save. 

19. Close RIL, and save settings when prompted. 

20. Optionally create a desktop shortcut to c:\RIL\RemoteISOLauncher.exe. 

 

4.4.4.4 Perform the Remote OS Install 
1. Open VNC Viewer Plus. 

2. These steps are optional. They will prevent the VNC session from timing out. 

 Click Options. 

 Click Advanced. 

 Select the Expert tab. 

 Set AMTSessionTimeout to 0. 

 Click OK. 

3. Enter the IP address of the remotely managed client system. 

4. Set Connection mode to Intel AMT. 

5. Set Encryption to None. 

6. Click Connect. 

7. If prompted, Click Yes to “Is <computer> the expected fully-qualified domain 

name of <ip>”? 

8. Enter your Intel AMT Admin credentials and click OK. 

9. Enter a User Consent Code if prompted. 

10. You can now interact remotely with the managed PC.  

11. This step is optional. It will ensure Windows is not forcefully shutdown. In the VNC 

Session, perform a graceful Windows shutdown. 

12. Open RIL. 

13. In the Host Name field, enter the IP address or FQDN of the managed client PC. 

14. Select the Settings tab. 

15. Enter authentication for username and password to Intel AMT. 

16. Select the Launch tab. 

17. Click the OS Reimage button in the boot image section. 

18. If prompted, click OK to the warning (“Warning, you are about to reboot the 

remote machine.  If the remote user has any unsaved work it may be lost.”). 

19. The managed client reboots first to iFast.iso, then to the Discovery Media on 

WDS. 

 

From here, the managed client PC will boot the WDS boot image.  Since KVM Remote 

Control is connected, any required interaction can take place remotely.  Any 

automation provided with WDSUnattend.xml will take place automatically. 



Intel® vPro™ Technology Solution Reference Design 

48  

NOTE 

By default, Windows 7 installs with a 100 MB partition for recovery operations.  This 

partition makes remote deployment and recovery more challenging.  Specifically, this 

will cause the Microsoft Deployment Toolkit task sequence for User Data Back to fail. If 

you did not use the WDSUnattend.xml file above, avoid the 100 MB partition do the 

following: 

1. When booted to WDS media press <Shift> - <F10> at the same time. 

2. A command prompt opens. 

3. Use diskpart to create and format a single partition that fills the hard drive. 

4. Type exit to close the command prompt 

5. Continue with WDS install and install to the partition created above. 

 

4.5 Additional Considerations 

4.5.1 Further Automation 

Intel vPro technology is used to initiate a boot to WDS media remotely and to 

interactively monitor the OS install process. All other functions are handled by WDS. 

As such, any automation supported by WDS can be used remotely. While automating 

WDS is outside the scope of this document, here are some ideas: 

 WDS can be integrated with MDT and Microsoft System Center Configuration 

Manager to aide in automation. 

 Images can have unattend.xml files attached for auto-configuring Windows. 

 WDS can capture gold images from existing computers for easier deployments. 

 WDS can manage drivers for automatic installation into Windows. 

The more automation, the less interaction is required from the help desk user. 

4.5.1.1 Boot to PXE in Intel vPro 

Intel vPro technology has a feature by with a boot one time to PXE can be set without 

KVM interaction.  This requires PXE to enabled in BIOS and console application 

support.  If a WDS install were fully automated, it would be possible to trigger a PXE 

boot that would then fully, automatically deploy Windows with no user interaction 

required. 

 

4.5.2 Scalability 

To scale to large deployments, multiple WDS servers may be configured. Consult WDS 

documentation for more information. 

When using the WDS PXE method above, no adjustments are needed to support a 

multi-server configuration.  WDS Discovery Media, however, takes a little more 

planning.  The recommendation is to create a Discovery media and ifast.iso pair for 
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each server.  Then, in RIL, add a button for each pair with a friendly name that 

denotes the server location.  By doing so, a help desk technician can start the process 

using the server nearest to the managed client PC in need of service. 

It is also recommended that you place the file discover.iso on a web server because 

downloading from a web server is usually faster than from a shared drive.  See 2 stage 

boot documentation for a web server based setup. 

Another consideration with WDS is its ability to do multicasting.  This reduces network 

load when performing multiple OS deployments at once.  Muticast will work when 

performing a remote deployment as described above.  See WDS documentation for 

performing a multicast install. 
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5 Microsoft Deployment Toolkit 

 

This section provides instructions on performing a remote OS re-image using Microsoft 

Deployment Toolkit (MDT). 

5.1 Overview 

The Microsoft Deployment Toolkit provides an easy method for managing and 

deploying OS images, yet is very flexible allowing support for almost any situation.  

This includes the ability to perform OS imaging remotely on Intel vPro based managed 

systems.  Below are basic steps to accomplish this use case.  This includes a basic 

installation and setup of the MDT for a Lite Touch OS Deployment, setting up for 

capturing user data, setting up a help desk console, and performing this use case.  The 

section concludes with discussion of deploying this into a production environment. 

5.2 Requirements 

 

Network with 
DHCP Server 

 

Reference 
Computer 

 Intel AMT 6.0 or higher 

Used to create the fresh OS image. This PC will have a fresh copy of 

Windows 7 installed. 

For the purpose of the lab, this PC may also be used as the Managed 
Client with Intel vPro Technology. 

Service Desk 
Console 

 Any PC with Microsoft Windows 7. 

Runs the MDT 

PC used by the Service Desk technician to remotely control the Knowledge 

Worker’s PC in the use case. 

Target Computer 
/ Managed Client 

with Intel vPro 
technology 

 Intel AMT 6.0 or higher 

 Intel Integrated Graphics 

 Configured for non-TLS and Digest credentials.  

This PC will have its OS reimaged during this use case. 

Note: Kerberos credentials are supported but not shown in this 

document. 
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5.3 Setup Service Desk Console 

In this section, the service desk console is configured, the MDT is installed, and all OS 

images are saved. 

5.3.1 Gather Required Supporting Files 

On the Service Desk Console, do the following: 

Win7 DVD 

Locate a Windows 7 installation DVD. It will be required for subsequent steps.  

WAIK 

On the Development PC, click the link below to obtain the Windows Automated 

Installation Kit for Windows 7. 

http://www.microsoft.com/download/en/details.aspx?id=5753 

This results in an .iso file.  Mount this .iso file (we suggest using Virtual CloneDrive for 

mounting .iso files) or burn it to a DVD and insert the DVD. 

Install the WAIK with default options (select Windows AIK Setup from the CD’s 

default GUI menu). 

WAIK SP1 

Note: if you do not have a DVD with SP1, skip steps for installing WAIK SP1. 

Download the WAIK for Windows 7 Supplement English 

http://www.microsoft.com/download/en/details.aspx?id=5188 

This results in an .iso file. Mount this .iso file (we suggest using Virtual CloneDrive for 

mounting .iso files) or burn it to a DVD and insert the DVD. 

Open a command prompt as administrator and run xcopy <drive>:\ "C:\Program 

Files\Windows AIK\Tools\PETools" /ERDY, where <drive>: is the drive letter 

representing WAIK SP1. 

5.3.2 Set Up MDT 

The following steps are derived from the MDT documentation, and provided as a 

means of quickly getting up and running.  Please refer to the MDT documentation for 

more details:  Print-ready documentation is available at this link: 

http://www.microsoft.com/download/en/details.aspx?displaylang=en&=tm&id=25175 

 

These steps were written using Windows 7 SP1 Enterprise 64 bit and MDT 2010 

Update1.  Adjust as needed for your specific configuration. 

 

NOTE 

The steps in the following subsections (5.3.2.x) are to be performed on the Service 

Desk Console. 

http://www.microsoft.com/download/en/details.aspx?id=5753
http://www.microsoft.com/download/en/details.aspx?id=5188
http://www.microsoft.com/download/en/details.aspx?displaylang=en&=tm&id=25175
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5.3.2.1 Install MDT 
1. Download MDT 2010 Update 1.  Be sure to get the appropriate version for the 

architecture of your Windows 7 installation, 32 bit or 64 bit: 

http://www.microsoft.com/download/en/details.aspx?displaylang=en&=tm&id=251

75 

2. Install MDT with default options. 

5.3.2.2 Create a Deployment Share  
1. Open MDT Workbench by clicking Start -> Programs -> Microsoft Deployment 

Toolkit -> Deployment Work Bench. 

2. In the navigation tree, right-click Deployment Shares and select New 

Deployment Share. 

3. Complete the New Deployment Share Wizard with the default options.  This results 

in a new folder named c:\DeploymentShare. It is shared as 

DeploymentShare$. 

4. Expand Deployment Shares and verify that MDT Deployment Share 

(c:\DeploymentShare) exists. 

5.3.2.3 Configure the Deployment Share 

In this step, default values for the deployment share UNC path are changed to use the 

FQDN, instead of just the system name.  

1. In the Deployment Workbench, expand Deployment Workbench -> Deployment 

Shares -> MDT Deployment Share (c:\DeploymentShare). 

2. Right-click MDT Deployment Share (c:\DeploymentShare) and click Properties. 

3. Adjust the Network (UNC) path so that the FQDN of the Service Desk Console is 

used.  For example: \\dtools.ent.vprodemo.com\DeploymentShare$.  

4. Click the Rules tab. 

5. Click Edit Bootstrap.ini. 

6. Notepad opens. Set the DeployRoot value so that the FQDN of the Service Desk 

Console is used.  For example: \\dtools.ent.vprodemo.com\DeploymentShare$.  

7. Close Notepad.  When prompted, save changes. 

8. Click OK. 

5.3.2.4 Add a Source OS 
1. Insert your Windows 7 SP1 DVD Media. 

2. In the Deployment Workbench, expand Deployment Workbench -> Deployment 

Shares -> MDT Deployment Share (c:\DeploymentShare) and select Operating 

Systems. 

3. Right-click Operating Systems and select Import Operating System. 

4. Select Full set of Source Files and click Next. 

5. In the Source Directory screen, enter the drive letter that corresponds to the 

Windows 7 SP1 DVD. For example. E:\. 

6. For the remaining screens, click Next to accept defaults; in the final screen click 

Finish. 

http://www.microsoft.com/download/en/details.aspx?displaylang=en&=tm&id=25175
http://www.microsoft.com/download/en/details.aspx?displaylang=en&=tm&id=25175
file://dtools.ent.vprodemo.com/DeploymentShare$
file://dtools.ent.vprodemo.com/DeploymentShare$
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5.3.2.5 Add Drivers for vPro LAN and MEI 

The MDT manages drivers for the target systems.  As such, any drivers may be added. 

However, the LAN drivers are required for this use case to be successful.  These steps 

only cover adding the LAN Drivers.  See the MDT documentation for more details on 

using MDT to manage and install drivers. 

1. Copy the LAN Driver pack and MEI Driver pack from this UCRD’s download file to 

c:\drivers\. 

2. In the DeploymentWorkbench, expand Deployment Workbench -> Deployment 

Shares -> MDT Deployment Share (c:\DeploymentShare) and select Out-of-Box 

Drivers. 

3. Right-click Out of Box Drivers and select Import Drivers. 

4. In the Driver source directory screen, enter one of the following: 

 For a 32 bit source Windows 7 SP1 DVD: 

c:\drivers\LAN\PRO1000\Win32\NDIS62 

 For a 64 bit source Windows 7 SP1 DVD: 

c:\drivers\LAN\PRO1000\Winx64\NDIS62 

5. Click Next. 

6. For the remaining screens, click Next to accept defaults; in the final screen click 

Finish. 

7. In the DeploymentWorkbench, expand Deployment Workbench -> Deployment 

Shares -> MDT Deployment Share (c:\DeploymentShare) and select Out-of-Box 

Drivers. 

8. Right-click Out of Box Drivers and select Import Drivers. 

9. In the Driver source directory screen, enter c:\drivers\MEI\7\MEI 

10. Click Next. 

11. For the remaining screens, click Next to accept defaults; in the final screen click 

Finish. 

12. In the DeploymentWorkbench, expand Deployment Workbench -> Deployment 

Shares -> MDT Deployment Share (c:\DeploymentShare) and select Out-of-Box 

Drivers. 

13. Right-click Out of Box Drivers and select Import Drivers. 

14. In the Driver source directory screen, enter c:\drivers\MEI\6\MEI 

15. Click Next. 

16. For the remaining screens, click Next to accept defaults; in the final screen click 

Finish. 
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5.3.2.6 Add a Task Sequence for a Windows 7 Deployment 
1. In the Deployment Workbench, expand Deployment Workbench -> 

Deployment Shares -> MDT Deployment Share (c:\DeploymentShare) and 

select Task Sequences. 

2. Right-click Task Sequences and select New Task Sequence. 

3. Set as follows: 

 Task Sequence ID: BASEW7SP1 

 Task Sequence Name: Base Windows 7 SP1 Install 

4. Click Next. 

5. Choose the Standard Client Task Sequence and click Next. 

6. Select the OS Image you imported earlier and click Next. 

7. You do not need to enter a serial number; click Next. 

8. Set an Organization. This document uses vprodemo.  Click Next. 

9. Select Do not specify and Administrator Password at this time and click Next. 

10. On the Summary screen, click Next. 

11. When complete, click Finish. 

 

5.3.2.7 Optionally add an application 

This step is optional.  It illustrates how to add an application like Notepad2 to be 

installed as part of the OS Deployment.  See the MDT documentation for selecting 

specific applications for a specific deployment. 

From http://www.flos-freeware.ch/notepad2.html download the x86 and x64 setup 

programs and save them to c:\apps\notepad2\<arch>\ where <arch> is x86 or 

x64.  At the time of this writing the latest version is 4.2.25. 

Once install package is obtained, command line parameters must be determined to 

perform a silent install.  Sometimes this can be done by running the installer 

executable from a command line with the /? argument or by looking at the software’s 

included documentation.  In this case the command line we want is 

Notepad2_4.2.25_<arch>.exe /SILENT. 

NOTE 

Write down the command line parameter information.  It will be used later in this 

procedure. 

 

1. In the Deployment Workbench, expand Deployment Workbench -> 

Deployment Shares -> MDT Deployment Share (c:\DeploymentShare) and 

select Applications. 

2. Right-click Applications and select New Application. 

3. Select Application with source files and click Next. 

4. Complete the form as follows: 

 Publisher: Flos Freeware 

 Application Name: Notepad2 x86 

http://www.flos-freeware.ch/notepad2.html
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 Version: 4.2.25 

 Language: English 

5. Click Next. 

6. For Source Directory enter c:\apps\notepad2\x86. 

7. Click Next. 

8. Click Next. 

9. For Command Line enter Notepad2_4.2.25_x86.exe /SILENT. 

10. Click Next. 

11. On the Summary screen, click Next. 

12. When complete, click Finish. 

13. Double-click the newly created application. 

14. Click the Details tab. 

15. Select This can only run on the specified client platforms. 

16. Select All x86 Vista and Newer (near the bottom of the list) 

17. Select All x86 Pre-Vista (near the bottom of the list). 

18. Click OK. 

19. Repeat this process for the x64 version of Notepad2. 

 

5.3.2.8 Optionally add a custom script 

This step is optional. While the default settings can get the job done in many cases, 

the MDT is highly customizable. This illustrates how to add a custom, post install script 

to the task sequence. See the MDT documentation for detailed information on adding 

custom scripts, task sequence steps, automating a Lite Touch Deployment, 

customizing the Lite Touch Wizard, etc. 

This will execute a command to disable User Account Control, and then reboot the 

system so the change will take effect. 

 

1. In the Deployment Workbench, expand Deployment Workbench -> 

Deployment Shares -> MDT Deployment Share (c:\DeploymentShare) and 

select Task Sequences. 

2. Double-click Base Windows 7 SP1 Install Properties. 

3. Click the Task Sequence tab. 

4. In the navigation tree, expand State Restore -> Custom Tasks and select 

Custom Tasks. 

5. Click Add -> General -> Run Command Line. 

6. In Command Line, enter the following: 

%windir%\System32\cmd.exe /c %windir%\System32\reg.exe ADD 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\

System /v EnableLUA /t REG_DWORD /d 0 /f 

7. Select Custom Tasks. 

8. Click Add -> General -> Restart Computer. 

9. Click OK. 
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5.3.2.9 Optionally add a task sequence to perform data backup 

This step is optional.  Using the task sequence created above will cause a new copy of 

Windows to be installed.  In some scenarios, it is desirable to first capture any user 

data and OS settings and/or create a full computer backup before installing the new 

OS.  To accomplish this goal on a system that will not boot into Windows, a custom 

task sequence must be created.  If user data backup is not desired, skip these steps. 

NOTE 

User data is backed up using the User State Migration Tool.  Following these steps will 

use the default USMT configuration.  See the MDT documentation for details on 

customizing user data backup with the USMT and for other options related to system 

backup and restore. 

 

NOTE 

This task sequence is designed for use when Windows is installed on the first partition 

of the first hard drive in the system.  When performing the initial OS install using the 

instructions in this document, this will be the case.  However, when Windows 7 is 

installed manually with the default partition options the first partition will be a hidden, 

100 MB partition.  This will cause the task sequence below to fail.  As such, it is 

recommended not to use the 100 MB partition.  See the MDT and Microsoft Windows 

documentation for more details. 

 

1. In the Deployment Workbench, expand Deployment Workbench -> 

Deployment Shares -> MDT Deployment Share (c:\DeploymentShare) and 

select Task Sequences. 

2. Right-click Task Sequences and select New Task Sequence. 

3. Set an ID and Name. The document example uses: 

 USERDATABACKUP for ID 

 Backup User Data From Offline Windows for Name 

4. Click Next. 

5. For Template, select Standard Client Replace Task Sequence and click Next. 

6. On the Summary screen, click Next. 

7. Click Finish. 

8. Double-click the new Task Sequence created above. 

9. Click the Task Sequence tab. 

10. From the navigation tree, select State Capture. 

11. Click Add -> General -> Set Task Sequence Variable. 

12. Set the new step as follows 

 Name: OriginalDiskIndex 0 

 Task Sequence Variable: OriginalDiskIndex 

 Value: 0 

13. Click the Up button until this step is the first item under State Capture. 
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14. From the navigation tree, select State Capture. 

15. Click Add -> General -> Set Task Sequence Variable. 

16. Set the new step as follows: 

 Name: OriginalDiskPartition 1 

 Task Sequence Variable: OriginalDiskPartition 

 Value: 1 

17. Click the Up button until this step is the second item under State Capture. 

Note: these settings define from which hard drive and partition user data and 

settings backed up.  These settings work for the default partition scheme used by 

MDT.  These match the default MDT hard drive partitioning scheme, adjust these 

values as needed. 

18. Select Capture Groups and click Remove. 

19. Select Apply Windows PE. 

20. Enter x:\ in the Start in: field, as shown in Figure 10 below. 

 

Figure 10:  Task Sequence Screen 

21. Click OK. 

 



Intel® vPro™ Technology Solution Reference Design 

58  

Now create a share to store any data that is backed up. 

1. Create a folder c:\migdata. 

2. Right-click and choose share with specific people.  Be sure an administrator 

account has read/write access and click Share.  

3. When complete, click Done. 

NOTE 

Consult the MDT documentation for details on setting security on this share as well as 

for space requirements planning. 

5.3.2.10 Create the LiteTouch bootable media 
 

1. In the Deployment Workbench, expand Deployment Workbench -> 

Deployment Shares and select MDT Deployment Share 

(c:\DeploymentShare). 

2. Right-click MDT Deployment Share (c:\DeploymentShare) and select Update 

Deployment Share. 

3. Select Completely regenerate the boot images. 

4. On the Summary screen, click Next. 

5. When complete, click Finish. 

 

5.3.3 Additional Work for Remote Use 

At this point, the LiteTouch bootable media could be burned to a disk and then used to 

start and complete an OS deployment.  However, this use case is about performing the 

OS Deployment remotely.  These steps get the service desk console ready. 

RealVNC VNC Viewer Plus is used to monitor the Reimage Process.  Although not 

covered in this document, you may use alternate KVM Remote Control software for 

this purpose. 

ISO Builder helps create WinPE ISO images for Remote use.  In this case it’s used to 

create new lite touch media that does not ask to “Press Any Key to Boot”. 

2 stage boot is used to speed the remote booting process. 

Remote ISO Launcher (RIL) is used to perform the IDE Redirection process. It also 

provides automation support.  

 

On the Service Desk Console, perform the following steps to install VNC Viewer Plus, 

ISO Builder, 2 stage boot, and RIL. 

 

1. Download and install RealVNC’s VNC Viewer Plus: 

http://www.realvnc.com/products/viewerplus/index.html  
 

2. Included with this document is the ISO_Builder package. Copy it to c:\ISO_Builder 

http://www.realvnc.com/products/viewerplus/index.html
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3. Drag and drop c:\DeploymentShare\boot\LiteTouchPE_x86.iso onto 

c:\ISO_Builder\no_pak.bat. This will create 

c:\DeploymentShare\boot\LiteTouchPE_x86.iso.no_pak.iso. 

4. Repeat step 3 for c:\DeploymentShare\boot\LiteTouchPE_x64.iso. 

5. Download 2 stage boot from 

http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20960&lang=

eng&OSVersion=&DownloadType= .  

6. Extract to c:\ifast. 

7. Run c:\ifast\ifast.hta. 

8. Complete the form as desired.  This document uses: 

 Try Local Hard Drive: No 

 Try Network Resource: Yes 

 Take Input From: KVM Session 

 Download Type: Share Drive 

 Username: <itproadmin> 

 Password: <P@ssw0rd> 

 Domain: <IP of Service Desk> 

 Path: \\<IP of Service Desk>\DeploymentShare$\boot 

 Image: LiteTouchPE_<arch>.iso.no_pak.iso. Note: Be sure <arch> 

matches the architecture of your Windows 7 install. 

9. Click Save. 

10. Click Build ISO. The ISO file c:\ifast\ifast.iso is created. 

11. Download Remote ISO Launcher (RIL): 

http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20961&lang=

eng&OSVersion=&DownloadType= .  

12. Extract the RIL files to c:\RIL. 

13. Launch RIL by double clicking on c:\RIL\RemoteISOLauncher.exe. 

14. Click the CD icon. 

http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20961&lang=eng&OSVersion=&DownloadType
http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20961&lang=eng&OSVersion=&DownloadType
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Figure 11:  CD Icon on RIL Interface 

15. Type in a friendly name such as “OS Reimage”. 

16. Click Browse. 

17. Select c:\ifast\ifast.iso. 

18. Click Open. 

19. Check the box titled “Reset boot path after launch”. 

20. Click Optionally select a color for the button. 

21. Click Save. 

22. Close RIL, and save settings when prompted. 

23. Optionally create a desktop shortcut to c:\RIL\RemoteISOLauncher.exe. 
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5.4 Perform the Remote OS Install  

5.4.1 Optionally Perform User Data and System backup for later 

migration 

In this step, user data and possibly the entire system is backed up using the Backup 

User Data From Offline Windows task sequence created above. This step is 

optional. If run, the following step will replace any data that was backed up. 

NOTE 

This task sequence is designed for use when Windows is installed on the first partition 

of the first hard drive in the system.  When performing the initial OS install using the 

instructions in this document, this will be the case.  However, when Windows 7 is 

installed manually with the default partition options the first partition will be a hidden, 

100 MB partition.  This will cause the task sequence below to fail. As such, it is 

recommended not to use the 100 MB partition.  See the MDT and Microsoft Windows 

documentation for more details. 

 

On the Service Desk Console, do the following: 
 

1. Open VNC Viewer Plus. 

2. These steps are optional.  They will prevent the VNC session from timing out. 

 Click Options. 

 Click Advanced. 

 Click the Expert tab. 

 Set AMTSessionTimeout to 0. 

 Click OK. 

3. Enter the IP address of the remotely managed client system. 

4. Set Connection mode to Intel AMT. 

5. Set Encryption to None. 

6. Click Connect. 

7. If prompted, Click Yes to “Is <computer> the expected fully-qualified domain 

name of <ip>”? 

8. Enter your Intel AMT Admin credentials and click OK. 

9. Enter a User Consent Code if prompted. 

10. You can now interact remotely with the managed PC. 

11. This step is optional. It will ensure windows is not forcefully shutdown.  In the VNC 

Session, perform a graceful Windows shutdown. 

12. Open RIL (c:\RIL\RemoteISOLauncher.exe). 

13. In the Host Name field, enter the IP address or FQDN. 

14. Select the Settings tab. 

15. Enter authentication for username and password to Intel AMT. 

16. Select the Launch tab. 

17. Click the OS Reimage button in the boot image section. 
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18. If prompted, click OK to the warning (“Warning, you are about to reboot the 

remote machine.  If the remote user has any unsaved work it may be lost.”). 

19. The managed client reboots first to iFast.iso, then to the Lite Touch Media on the 

deployment share. 

20. Upon boot, the Welcome Windows Deployment window appears.  Click Run the 

Deployment Wizard to install a new operating system. 

21. Enter administrator credentials for the deployment share.  For example, the 

administrator username and password for the Service Desk Console. 

22. Click OK. 

23. If you want to back up just the user data, not a full computer backup, choose the 

Backup User Data From Offline Windows task sequence. Otherwise skip ahead 

to step 25. 

24. Specify a location as \\<ip address of service desk>\migdata and click Next. 

25. If you wish to create a full computer backup, specify a location as \\<ip address 

of service desk>\migdata.  Otherwise select Do not back up the existing 

computer. Click Next. 

26. Click Begin.  The task sequence runs, backing up user data and setting, and 

optionally creating a full backup of the computer.  This may include automatic 

system reboots. 

27. When the process completes, click Finish.   

Note: if you do not click Finish before the next step, the computer will re-run the 

backup task sequence again. 

 

5.4.2 Erase the Client Hard Disk with diskpart 

The MDT is designed to repartition the hard disk as part of its process.  However, there 

are circumstances where the MDT will not be able to continue unless the hard disk has 

already been erased.  Further, performing a manual erase ensures any issues in the 

partitioning scheme are cleared.  As such, it is recommended to perform a manual 

hard disk erase using diskpart, as follows, prior to the actual Windows install. 

On the Service Desk Console, do the following: 
 

1. Open VNC Viewer Plus. 

2. These steps are optional.  They will prevent the VNC session from timing out. 

 Click Options. 

 Click Advanced. 

 Click the Expert tab. 

 Set AMTSessionTimeout to 0. 

 Click OK. 

3. Enter the IP address of the remotely managed client system. 

4. Set Connection mode to Intel AMT. 

5. Set Encryption to None. 

6. Click Connect. 

7. If prompted, Click Yes to “Is <computer> the expected fully-qualified domain 

name of <ip>”? 
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8. Enter your Intel AMT Admin credentials and click OK. 

9. Enter a User Consent Code if prompted. 

10. You can now interact remotely with the managed PC. 

11. Open RIL (c:\RIL\RemoteISOLauncher.exe). 

12. In the Host Name field, enter the IP address or FQDN. 

13. Select the Settings tab. 

14. Enter authentication for username and password to Intel AMT. 

15. Select the Launch tab. 

16. Click the OS Reimage button in the boot image section. 

17. If prompted, click OK to the warning (“Warning, you are about to reboot the 

remote machine.  If the remote user has any unsaved work it may be lost.”). 

18. The managed client reboots first to iFast.iso, then to the Lite Touch Media on the 

deployment share. 

19. Upon boot, the Welcome Windows Deployment window appears. Click Command 

Prompt to gain access to a command prompt. Note: if this screen does not 

appear, a plain WinPE boot disk may be used instead.  See 

http://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&DwnldID=20957&lang=

eng&OSVersion=&DownloadType= for creating and using WinPE. 

20. At the command prompt, execute the following commands. Note: these assume 

the system has a single hard disk.  

Warning: All data on this disk will be erased! 

 Diskpart 

 Select disk 0 

 Clean 

 Exit 

 Exit 

 

All data and partition information has now been erased. 
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5.4.3 MDT Windows install 

On the Service Desk Console, do the following: 
 

1. Open VNC Viewer Plus. 

2. These steps are optional.  They will prevent the VNC session from timing out. 

 Click Options. 

 Click Advanced. 

 Click the Expert tab. 

 Set AMTSessionTimeout to 0. 

 Click OK. 

3. Enter the IP address of the remotely managed client system. 

4. Set Connection mode to Intel AMT. 

5. Set Encryption to None. 

6. Click Connect. 

7. If prompted, Click Yes to “Is <computer> the expected fully-qualified domain 

name of <ip>”? 

8. Enter your Intel AMT Admin credentials and click OK. 

9. Enter a User Consent Code if prompted. 

10. You can now interact remotely with the managed PC. 

11. This step is optional.  It will ensure windows is not forcefully shutdown.  In the VNC 

Session, perform a graceful windows shutdown. 

12. Open RIL (c:\RIL\RemoteISOLauncher.exe). 

13. In the Host Name field, enter the IP address or FQDN. 

14. Select the Settings tab. 

15. Enter authentication for username and password to Intel AMT. 

16. Select the Launch tab. 

17. Click the OS Reimage button in the boot image section. 

18. If prompted, click OK to the warning (“Warning, you are about to reboot the 

remote machine.  If the remote user has any unsaved work it may be lost.”). 

19. The managed client reboots first to iFast.iso, then to the Lite Touch Media on the 

deployment share. 

20. Upon boot, the Welcome Windows Deployment window appears.  Click Run the 

Deployment Wizard to install a new operating system. 

21. Enter administrator credentials for the deployment share.  For example, the 

administrator username and password for the Service Desk Console. 

22. Click OK. 

23. Select Base Windows 7 SP1 install and click Next. 

24. Enter a name for this computer and click Next. 

25. Optionally enter desired options to join a domain.  This document uses the default 

workgroup setting.  Click Next. 

26. If data was backed up above, specify a location as \\<ip address of service 

desk>\migdata.  Otherwise, leave the default option.  Click Next. 

27. Optionally set language and other preferences. This document uses the default 

settings.  Click Next. 

28. Optionally set a time zone.  This document uses the default settings.  Click Next. 
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29. If applications where added above, they will now be listed. Select the desired 

applications and click Next. 

30. Select Do not capture an image of this computer and click Next. 

31. Select Do not enable Bitlocker for this computer and click Next. 

32. Click Begin.  The task sequence will now run with the selected options.  This will 

include formatting the hard disk, apply the Windows 7 OS, setting any custom 

settings, installing applications, restoring user information, etc.  This will include 

multiple automatic reboots.  

 

Congratulations, you have successfully reimaged a PC remotely. 

 

NOTE 

Upon a successful install it is recommended to click “Finish” on the wizard dialog and 

then perform a graceful Windows reboot.  See Appendix A under the error message 

“The task sequence has been suspended” for more information. 

 

5.5 Additional Considerations 

5.5.1 Scalable Deployments 

The steps above have the Deployment share placed on the same PC as the Service 

Desk Console.  In a live deployment, the more likely scenario is that the deployment 

share is hosted on a fast server, or multiple fast servers.  MDT documentation outlines 

various methods to creating a scalable deployment.  To adapt such a deployment for 

remote use, it is recommended to create multiple ifast.iso files, one for each 

deployment share.  Then, in RIL, add each one with a friendly name that tells the 

Service Desk Technician where the server is.  In this way, the closest share to a user 

can be easily chosen. 

 

5.5.2 Security 

The steps above use an administrator account for accessing the Deployment Share and 

the data migration share.  In general, it is best to use the least amount of privilege 

possible.  Further, it may be advantageous to grant permissions to service desk users 

based on their credentials, rather than using a universal login.  Refer to the MDT 

documentation on how this may be accomplished.  

 

5.5.3 Further Automation 

The MDT is capable of nearly 100% automation of OS deployment, once the LTI media 

has booted.  For example, task sequences, language, domain settings, and more can 
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be preset, selected based on computer type, and more.  While this is beyond the scope 

of this document, using the “Setup for remote use” steps above will make any 

deployment scenario available remotely. 

 

5.5.4 Additional MDT tips 

When the LTI Media created above first loads, it displays options to enter the recover 

environment and to open a command prompt.  Both of these tools can be used to 

remotely diagnose and repair the offline Windows OS or perform manual tasks like 

disk repartition or disk wiping. 
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A Appendix A: Troubleshooting 

This section provides information on the various error messages that may be 

encountered. 

 

Error: During MDT Install, “Setup was unable to create a new system partition or local 

an existing system partition. See the Setup log files for more information.” 

 

 

 

Error: During WDS Install, “Setup was unable to create a new system partition or 

local an existing system partition.  See the Setup log files for more information.  
 

Information: This error is coming from Windows installer. It does not detect the local 

hard drive as a bootable device.  In testing, this was observed on some Dell laptops, 

only when the hard drive controller is set to AHCI.  
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Error: MDT Lite Touch Media or WDS Discover media fails to fully boot when using 2 

stage boot to pull the media from a network location.  
 

Information: Some BIOSs are not fully compatible with 2 stage boot.  This issue was 

specifically observed on a Dell E6420 laptop.  Either: 

 Use 2 stage boot to pull the media from the local hard disk 

 Do not use 2 stage boot. Instead, use RIL to IDEr boot the desired media directly. 

 

 

Error: When installing via MDT, a Wizard Error occurs (see figure below) during the 

Windows login process.  

 

 

Information: There is an intermittent timing issue where the MDT script runs before 

the network driver has initialized, causing the script to stop.  There may other causes 

for this issue as well, such a DHCP configuration issue or a missing or broken network 

driver.  See Microsoft documentation for more details.  To work around the timing 

issue either: 

 Click Retry on the dialog. The script will check again, find the network adapter, 

and continue normally. 

 Add a delay to the MDT script that checks for network connectivity as follows: 

On the Service Desk Console, 

1. Open Notepad as administrator 

2. In Notepad, open c:\Deploymentshare\scripts\ZTIUtility.vbs 

3. Find Line 2307. It is in the Function ValidateNetworkConnectivity, just below the 

comment ‘check for network adapters present. Note: the line number may change 

if Microsoft Updates the MDT. 
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4. Add the following at this line: 

On error resume next 

Wscript.sleep(10000) 

On error goto 0 

 

 

Error: If you are testing MDT in a lab, doing multiple back to back remote reimages, 

you may experience an error, “The task sequence has been suspended.”  This error 

occurs when booting the Lite Touch Media. 

 

 

Information: There is left over task sequence information on the system’s hard disk.  

To clear this issue, simply erase the hard disk prior to performing the MDT install.  See 

http://social.technet.microsoft.com/Forums/en-US/mdt/thread/878b1938-2da8-4fec-

9611-2a0b7efb3cd3 for more information. 

To avoid this issue altogether; after every MDT Remote OS install, be sure to click 

Finish at the Lite Touch wizard completion and then perform a graceful OS reboot.  

This appears to clear any leftover task sequence information on the hard disk. 

http://social.technet.microsoft.com/Forums/en-US/mdt/thread/878b1938-2da8-4fec-9611-2a0b7efb3cd3
http://social.technet.microsoft.com/Forums/en-US/mdt/thread/878b1938-2da8-4fec-9611-2a0b7efb3cd3

